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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.



Ref. 017001000200 Rev. 2: 01-10-2024

e The Spartan Arduino PLC is Open Type Controller. It is required that you install the
Spartan Arduino PLC in a housing, cabinet, or electric control room. Entry to the
housing, cabinet, or electric control room should be limited to authorized personnel.
Failure to follow these installation requirements could result in severe personal injury
and/or property damage. Always follow these requirements when Spartan Arduino PLC

e In case of installation or maintenance of the Spartan PLC please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le controleur.

e Reportez-vous au Guide de l'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

e Lautomate Spartan Arduino PLC cest contréleur de type ouvert. Il est nécessaire
d'installer I'automate Spartan Arduino PLC dans un boitier, une armoire ou une salle
de controle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation de l'automate
Spartan Arduino PLC.

e En cas d'installation ou de maintenance du Spartan PLC, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY
SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR
ENSURING SAFETY OF PERSONS, AS THEY ARE NOT RATED OR DESSIGNED FOR SUCH
PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT
ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED TO ADDRESS THE
RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED
AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR
SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or
use of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.
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At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.

Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the
indications and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result
of INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
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application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on vyour request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection
technology — Response times of the controller and drive — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — Parameterization, programming, cabling, and installation errors — Use
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of radio devices / cellular phones in the immediate vicinity of the controller — External
influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions —
Influence of electrostatic charging — Induction of voltages in moving motors —
Operating and/or ambient conditions not within the scope of the specification —
Condensation / conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR
IMPLIED, REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR FITNESS FOR
PARTICULAR PURPOSE OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT
THE BUYER OR USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY
MEET THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY
CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT,
WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.
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IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, REPAIR OR
OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS
CONFIRMS THAT THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND
MAINTAINED AND NOT SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR
INAPPROPIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

RECOGNIZED
COMPONENT
o™ Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
C us Certified to CSA Std. C22.2 No. 61010-1
LISTED Certified to CSA Std. C22.2 No. 61010-2-201
Intertek
5016476
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INDUSTRIAL SHIELDS

1. General Description SPARTAN 21 I/Os product

1.1. Zone - Nomenclature
The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and B the shield from above. It has 2 zones (A, B):

e The inputs in the zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X.

A ZONERL
B ZOMNEj)»

12
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1.2. Zone Distribution

ZONEA |—>=| ZONEB

Communication

-/
Digital

L

The distribution of the different features that provide the Spartan 21 1/Os is the following one:

Shield B Zone
12 Inputs
(12 Digital inputs, 6 of which can work as Analog Input)
Analog Shield
8 Outputs

(8 Digital Outputs, 3 of which can work as Analog Output)

1.3. A Zone Features

Shield A Zone

(1x) Ethernet

(1x) USB
Communication (3x) TTL
Shield
(1x) RS-232

(1x) HALF Duplex RS-485

13



Ref. 017001000200

1.4. Mechanical dimension
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1.5. General Features

CONECTABLE PLC ARDUINO 24Vcc SPARTAN

MODEL TYPE Spartan Arduino PLC 21 I0s
Fuse protection (2.5A)
Input Voltage 12 1o 24Vde Polarity protection
Input rated voltage ch
Rated Power 30 W
| max. 1.5A
Size 101x70.1x119.5
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

Ethernet Port — USB — RS485 — RS232 — (2x) Rx, Tx
(Arduino pins)

Max232-Max485-W5500

USB consideration!

Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vce)

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Digital Isolated Input
(24Vcce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

14
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* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vcce)

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated
Output (24Vvcc)

5 to 24Vdc
| max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated
Output Relay

220V Vdc
| max: 5A
Galvanic Isolation
Diode protected for Relay

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Expandability

Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15
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2. Technical Specifications:

2.1. General Specifications:

Item

Spartan PLC Arduino Ethernet 21 1/0s Analog/Digital PLUS

Power supply

voltage DC power supply

12 to 24Vdc

Operating

voltage range DC power supply

11.4 to 25.4Vdc

Power

consumption DC power supply 30W max.
Power supply Javde ===
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all
the external AC terminals and the protective ground terminal.

Shock resistance

80m/s%in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

02 to 602C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -202 to 602C
Power supply holding time 2ms min.
Weight 378g max.

2.2. Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http:/arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader
Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz
Clock Speed 16MHz

16
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Table that includes all the symbology that is used in the serigraph of the Spartan Arduino PLC

21 1/0s Analog/Digital:

Symbol

IL
ik
X

q
VAN
(

Standard No. /
Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

Medical Devices
Directive
93/42/EEC

ISO 7000/
Graphical symbols
for use on
equipment

ISO 7000/
Graphical symbols
for use on
equipment

Standard
Reference No. /
Symbol Title
5031 / Direct
Current

5032 / Alternating
Current

5130/ Pulse
General

5017 / Earth,
Ground

5115 / Signal lamp

CE Marking

0434B/
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment
is suitable for direct current
only; to identify relevant
terminals

Indicates that the equipment
is suitable for alternating
current only; to identify

relevant terminals

To identify the control by
which a pulse is started.

To identify an earth (ground)
terminal in cases where
neither the symbol 5018 nor
5019 is explicily required.

To identify the switch by
means of which the signal

lamp(s) is (are) switched on or
off.

CE marking indicates that a
product complies with
applicable European Union
regulations
Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

To indicate hazards arising
from dangerous voltages

17
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3. Precautions

Read this manual before attempting to use the Spartan Arduino PLC 21 1/Os Analog/Digital and
follow its descriptions for reference during operation.

3.1. Arduino Board

The Spartan 21 1/0s PLCs include Arduino Mega Board as controller.

3.2. Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3. General Precautions

The user must operate Spartan according to the performance specifications described in this
manual.

Before using Spartan under different conditions from what has been specified in this manual or
integrating Spartan to nuclear control systems, railroad systems, aviation systems, vehicles,
combustion systems, medical equipment, amusement machines, safety equipment and other
systems, machines, and equipment that may have a serious influence on lives and property if
used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and
performance characteristics of Spartan are sufficient for the systems, machines, and
equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the Spartan.

3.4. Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

o Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

18
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4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network:

Sketchboal: location:

Ci\Users\Albert\DocumentsiArduino Browse
Editor language: English (English) ~ | (requires restart of Arduino)
Editor font size: 15

Interface scale: Automatic | 100 % %  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: None  ~

[ bisplay line numbers

[[JEnable Code Folding

Werify code after upload

[ Use external editor

Check for updates on startup

Update sketch files to new extension on save (pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs: )'mp://apps‘mdusma\sh\e\ds.cnmfma\nfardum/hnards/pac\'age_\nﬂusma\sh\elds_\nde ﬁ

More preferences can be edited directly in the file
Ci\Users\Albert\AppDatal_ocal\Arduino15\preferences. bt

(edit only when Arduino is not running)

oK Cancel

2. In Additional Boards Manager URLs write the following:

3. Press OK to save the changes.

19
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4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch mar16a | Arduino 1.80
File Edit Sketch Tools Help

sketch_mar16|

id setup|
put y|

1
bid loop(
put v

H
|

5. Search for

Auto Format
Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WiFi101 Firmware Updater
Board: "M-Duino family"
Industrial Shields: "M-Duino 58+"
Port

GetBoard Info

Programmer: “Arduino as ISP'
Burn Bootioader

Boards Manager...
Arduino AVR Boards

Ardhino Yin

Ardhino/Genuino Uno

Arduino Duemilanove or Diecimila
Arduino Nano

Arduino/Genuino Mega or Mega 2560
Arduino Mega ADK

Arduino Leonardo

Ardhino Leonardo ETH
Arduino/Genuino Micro

Arduino Esplora

Arduino Mini

Arduino Ethernet

Arduino Fio

Ardlino BT

LilyPad Arduino USB

LilyPad Arduino

Arduino Pro or Pro Mini

Arduino NG or older

Arduino Robot Control

Ardino Robot Motor

Ardhino Gemma

Adafruit Circuit Playground

Arduino Yin Mini
Arduino Industrial 101
Linino One

Arduino Uno WiFi

Industrial Shields boards
Ardbox family
® M-Duino family

ndustrialshields” on the browser.

Rev. 2: 01-10-2024

& Boards Manager

4 Type All ~ | lindustrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duina family.
Online help

More info

~ | Install

Close
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6. Click install (selecting the latest version).

Following these steps, you will be able to see now the Industrial Shields Boards:

© sketch_dec09a Arduino 1.8.13 — X

Archivo_Editar Programa Herramientas  Ayuda

Auto Formato Cul+T
Archivo de programa.
Reparar codificacion & Recargar.

| Administrar Bibliotecas.. Ctrl+Maytis+1 5
1P (] Monitor Serie Ctrl+Mayts+M
// put yol SerialPlotter CtlsMayis+L e :

'WiFi101 / WIFiNINA Firmware Updater
} Placa: “Spartan family” 3 Gestordeta
Model: “Spartan 19R"
Puerto
void lo op ( ) Obtén informacion de la placa
// put you  pogramador

Quemar Bootloader

ESP32 Arduino
Industrial Shields boards
pdustrial Shields ESP32 masefe

Ardbox family
Ardbox DALI family
Ardbox GPRS family
Ardbox WiFi/BT family
} Ardbox LoRa family
M-Duino family
M-Duino DALI family
M-Duino GPRS family
M-Duino LoRa family
M-Duino Wii/BT family
@ Spartan family

Spartan family, Spartan 19R =n COM29

Once it is selected Spartan family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

© sketch_dec09a Arduino 1.8.13 - X

Archivo_Editar Programa Herramientas Ayuda

o o m E g Auto Formato Ctrl+T
Archivo de programa
sket <00 Reparar codificacion & Recargar.

Administrar Bibliotecas. Ctrl+Mayus+|

void setup () vonitor serie Ctrl+Mayds+M
// put yol Serial Ploter CtisMaylssL e :
'WiFi101 / WIFiNINA Firmware Updater
} Placa: "Spartan family" >
Model: “Spartan 21" 3 Spartan 16DA
. Puerto 3 Spartan 16RDA
void 1oop () | obteninformacién de la placa Spartan 19R
@ Spartan21
// put Yo  programador L. .

Quemar Bootloader

Also, there are some examples of programming in File -> Examples -> Spartan family.
Furthermore, there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields
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5. How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
Spartan 21 1/Os uses USB-B cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Spartan family

- Select the correct Spartan Board (Spartan 21).

© sketch_dec09a Arduino 1813
Archivo Editar Programa Herramientas Ayuda

Auto Formato

Archivo de programa

Reparar codificacion & Recargar.
Administrar Bibliotecas...
Monitor Serie

Serial Plotter

Ctl+T

Ctrl+Mayus+|
Ctrl+Mayus+M
Cl+MayissL  nce:

void
//

setup (]
put you
WiFi101/ WIFININA Firmware Updater

} Placa: “Spartan family” >
Model: “Spartan 21 j

Puerto v
Spartan 19R
partan 21

Spartan 16DA

void

//

loop ()
put yot

Obtén informacion de la placa

Programador
Quemar Bootloader

Spartan family en COM28

- Select correct port.

© sketch_dec09a Arduino 1813
Archivo Editar Programa Herramientas Ayuda
Auto Formato Ctrl+T
Archivo de programa.

Reparar codificacion & Recargar.
‘Administrar Bibliotecas.

- o x
E
-]

Ctrl+Mayus+|

void setup (] wonitorsere Ctrl+Mayls+M
// put you SerialPlotter Ctrl+Maytis+L
'WiFi101 / WiFiNINA Firmware Updater
} Placa: "Spartan family” >

Model: “Spartan 21"

Puerto: "COM3 (Arduino Mega or Mega 2560)"

void loop ()
// put yol

Obtén informacion de la placa

Programador
Quemar Bootloader

>
8 Puertos Serie

| COM3 (Arduino Mega or Mega 2560)
sfedly:
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6. How to connect PLC to power supply

- Spartan 211/0s PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

|::"."f ER SUPP LTl

— ~cmo |

I —f el A1e |

| I ———

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

12Vdc / 24vd =
- o} (o}

-2.5A . +E_ -
30W

Industrial Shields power supplies provide parallel operation,
overvoltage protection, and overcurrent protection.
There is a LED inductor for power status,

TRBY |

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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7. Spartan 21 I/0Os Pinout

7.1. A Zone connection

Base
(common unit)

III |

WAVZ O 21

‘” R AIMD

Rev. 2: 01-10-2024

Arduino direct pins

Communication Pins

Power supply connectors
(24vdc — GND)

CA; :én
im.12/24Vde
30w

<
L
*RTC Battery 5‘.&(220»

oC€

RESET/ USB-8 *Program’

?

o
¢

"AUTORESET

g

A Zone
SPARTAN Arduino .
. Function
Connector Pin
AREF AREF Arduino PIN
sQW sQw Arduino PIN
IOREF IOREF Arduino PIN
3.3vdc 3.3Vdc Arduino PIN
5Vvdc 5Vdc Arduino PIN
GND GND GND
NC - Not Connected
NC Not Connected
RX0 1 RX0
TXO0 0 TXO0
RX1 19 RX1
TX1 18 X1
TX 16 RS232
RX 17 RS232
NC - Not Connected
NC - Not Connected
B- - RS485
A+ - RS485
NC - Not Connected
NC - Not Connected
NC - Not Connected
NC - Not Connected
NC - Not Connected
V5 5vdc 5V
PIN2 2 Arduino Pin
GND - GND
GND - GND
24Vdc - Power Supply
’
:
d
Ethernet Arduing -~
Connector Reset button

*uSD Socket[J | \

Power \

USE programmer
connector

Autoreset

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using

serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2. B Zone (Analog Shield)

B Zone
Spartan Arduino E .
. unction
Connector Pin
10.12 59 Analog/ Digital In
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55 Analog/ Digital In
10.7 54 Analog/ Digital In
(-)10.6/INT1 - GND 10.6
10.6/INT1! 3 Interrupt 1 In
NC - Not Connected
NC - Not Connected
(-)10.4 - GND 10.4
10.4 26 Digital Input
(-)10.3 - GND 10.3
10.3 25 Digital Input
(-)10.2 - GND 10.2
10.2 24 Digital Input
(-)10.1 - GND 10.1
10.1 23 Digital Input
(-)10.0 - GND 10.0
10.0 22 Digital Input
Top Zone

Led indicator /05 state

B Zone

Spa Ar
rtan du
Con in Function
nec )

tor Pi

n
GND GND GND
A0.7" 6 Analog Out
A0.6' 5 Analog Out
A0.5 4 Analog Out
Q/Vdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND

Q0.7" 6 Digital/PWM Out
Q0.6' 5 Digital/PWM Out
Q0.5" 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Qut

Rev. 2: 01-10-2024

o
Analog:
0-10vdc
Digital
5-24vdc

<
Digital:
5-24vdc

GND —|

10.12 —o(T %
10.11 —ofT
10.10—ofTF
109 —ofTp
10.8 —offx
10.7 —offx
() I0BANT 1
10 B/INT 1<%
() ID.5ANTOY
10 5/INTD%

() 104
104 %
() 10.3—
03 —o
() 10.2—
02 o
()10.1—
101 o
(-)10.0—
100 —o%

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

EEEG

il 7
i
il
CiLd
Ci3
il
Gl
K]

Configuration Switch®
(5ee seclion & to select the
correct configuration for outputs).

Analog Outputs

Woltage Supply/Reference for
DigitallPWh Outputs (isolated)

PWh/Digital Outputs

! See section 8 to select suitable switch configuration for enable these connections.
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8. Switch Configuration

SWITCH OFF | ON
NC/NC - -
A0.7/Q0.7 | A0.7 | Q0.7
A0.6/Q0.6 | A0.6 | Q0.6
A0.5/Q0.5 | AO0.5 | Q0.5

OFF ON
NC NC
A0.7 Q0.7
A0.6 Q0.6
A0.5 Q0.5

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF,
it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A0.X, being X any number of the tables above.
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9. SPARTAN Arduino I/Os 5V pins

The SPARTAN ARDUINO PLC 19R 1I/Os Analog / Digital has some of the Mega board pins
available. These pins can be programmed according to Arduino features such as 1/Os operating
at 5V or any additional features present in the pins. As these pins are directly connected to the
Arduino Mega board, they are not as well protected as the normal inputs. These pins are
mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 8) and some extra
considerations must be taken in consideration when using these pins.

SPARTAN terminal Arduino pin Enable Arduino pin
RX0 0
TXO0 1
RX1 19 Communication switch OFF
TX1 18 Communication switch OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

Apart from the switch configuration, there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1. Serial 0 - RX0/TXO0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time. When the PLC is not installed, the USB communication is normally required for
debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external
pull-up or pull-down circuit could be set.
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9.2. Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. The RX1/TX1 pins will only be available
if the switch configuration is in OFF position. If not using the Serial 1 interface these pins
can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration by default. The
Arduino board allows the pins to be set in a pull-up configuration. Otherwise, an external
pull-up or pull-down circuit could be set.

9.3. Pin 2

This pin is referred to the input 10.1. This pin is not established with a pull-up or a pull-down
configuration by default. The Arduino board allows the pin to be set in a pull-up configuration.
Otherwise, an external pull-up or pull-down circuit could be set.
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10.A Zone Features: Communications & uSD

10.1.RS-232

The Arduino Mega function code to access the RS-232 port in the SPARTAN is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there is not any switch that affects it. So, it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields there is a library that simplifies the RS-232
implementation.

10.2.RS-485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart

below.

Function Arduino Pin
DI 14

RO 15

RE 11

DE 46

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3.TTL

SPARTAN has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

10.4.Ethernet

SPARTAN Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the SPARTAN. In the SPARTAN, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).
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11.Instructions for interconnection between Industrial

Shields controllers

11.1.RS-232 Communication:

< M-Duino 19R
| 1/0s PLUS

Ferrite KITA
GND

12/24V

_—

KRFC-6 Ferrite (4 Loops)

SHIELDED CABLE

11.2.RS-485 Communication:

* M-Duino 19R
I0s PLUS

e § DS

KRFC-6 Ferrite (4 Loops)

SHIELDED CABLE

~_Another Industrial
| Shields PLC

X ps232

Ferrite KITA

GND
W 12/24V

*_Another Industrial
| Shields PLC

RS-485

m

Ferrite KITA

GND
J@OOO( 12124V

SHIELDED CABLE

i ==

Ferrite KITA
GND [
12124V
11.3.Ethernet
KRFC-6 Ferrite
M-Duino 19R
I/Os PLUS
Ferrite KITA
GND i
12/24V
i _J  —

- Another Industrial
Shields PLC

Fermrite KITA
GND

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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12.1/0 technical details:

Digital Output Waveform:

[T o ———1
v

DIGITALOUT

M 288ms

>

DIGITAL OUT

PWM OUTPOUT

CH1 % Z@Eml)

J A

CH1 ¥ 26EEml

Rev. 2: 01-10-2024
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Analog Out Turn On:

]

ANALDG OUT
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13.Typical Connections

GND ‘*} (-)10.0
52124V o o)1 10

SHIELDED CABLE
Ferrite KITA

S Rl S

SHIELDED CABLE / Dowrsoad B MDUING LAYOUT:

From:

B

Ferrite KITA
= 9 POWER

2724V B oomuwm

SHIELDED CABLE ,J Douniod oo MOURO LAYOUT:
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SHIELDED CABLE
2124V o o

Ferrite KITA
5

U )" e,

SHIELDED CABLE  /  Fewwwndesesesiom
< >

—m— 0.7

Ferrite KITA

SO - —

Dorsined Fre MOUING LAYOUT:

SHIELDED CABLE i* From: www industriaishisids. com \\
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0-10V
SHIELDED CABLE
a mm%m—- 0.7
GND
Ferrite KITA
GND '['B POWER
12724V B pomauanaoow

SHIELDED CABLE Duroed S MOURNO LAYOUT:
SN

DIGITAL ISOLATED QUTPUT

SHIELDED CABLE
Q/vde £\ 82724V
ALWAYS
CONNECTED
Ferrite KITA 000 ®
oo 1o POWER VOUT = @/ Vide
224V [ DIGITAL OUT

SHIELDED CABLEf oot mave s \_
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SHIELDED CABLE

Gﬂb{ﬁ

2124V

Ferrite KIT/

Rev. 2: 01-10-2024

VOUT = Q/Vde

SHIELDED CABLE

DIGITAL / PWM ISOLATED
OUTPUT

Ferrite KIT

" \
E
v [

Qlvde
COM (-)
A a0s
POWER
I DIGITALPWA OUT

* Sew the swilch
configutarion (ON)
f 512724V
{ o A
J ALWAYS
JU1 CONNECTED
® SHIELDED CABLE
VOUT = Q/ Vide

36



Ref. 017001000200 Rev. 2: 01-10-2024

* 500 the switch
configutanion [ON)
1 A
ALWAYS
Jun CONMNECTED
Ferrite KITA @
_“:[9] VOUT = 0./ Vido
12124V
SHIELDED ASL%
\Wi .
SHIELDED CABLE
* Analog Outs no led ,ff
indicator
Qe * See the switch
or Dii Oles configutarion (OFF)
os 0 IC‘ 04 GND
030 p Oloz i | v 0-1W)
¥ AD.S
B
Mg e SHIELDED CABLE
NG D O tﬂ/
Ferrite KITA — o
GND
(=) ) POWER
224V } r ANALOG OUT

SHIELDED CABLE/J Dourioad the MOUINO LAYOUT: l\

Froem: svew, indusinialsiiedds com
"
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14.Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5
THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15.Mechanical Characteristics

- Dimension Spartan 21 1/Os:

101

129
14

- DIN Rail mounting

Profilato o cappello TH 35-7,5 Profilato o coppello TH 35-15
Top hot rail TH 35-7,5 Top hat rail TH 35-15
155
o
155
-—~—| 1004
15°
RO8
R12
R 08
g ! 1004
Sezione A / Section A R12
2,2 min. fino.a / To 2,5 max
R

2402

Sezione A/ Sedtion A

CARATTERISTICHE METODO ~ UNTA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PC/ABS METHOD PUABS

Mecconiche  Resisoza o tazieobosienomerto  JSTMD3E MR 68 Mechanicol test Resiconce o torslo stoss ot ASTIDE3B P 68
Resishin o tazione o witw JTMDB38  MPo 48 Tnslesiength ASTIDE3E b 48

Alogometo a tatun JTMDB3E % 5 U o ASTIDE3B % 5

Modubo in fesions MTMDT0  MPo 269 Floing modulis ASTDT0 MR 269

Prova Lzad conintoglio 5018014 X 5 lrod st notched 15016014 X/m' 55

Termiche Teng di mma limento Vit meido B STMDISES °C L} Thermal test Vit sodhoring tamperatis mithod B ASTMDISS  °C 1
Tomperatum Ricoth 1 B1 MPy MSTMDBE  °C 97 Rebieting ‘o pratue 181 MPo ASTMD64B  °C 97

Fisiche Peso spafn XTAD79) g3 121 Physicol test  Spacic gmuity ASTMD79?  qoiemd L
R nelo stompo KIS % 04/04 Mould shithage ASTIDSS % 0406

Mk Flow Index 260°C - 98N SIMDIZ38  gi10° 111 Mt Fow Index 260°C - 98N ASTHD1238  qo/I0' 111
Comportamento Auestinguerea (i di pesoe) U - V-0(08) Flame test  Selfetinguisher (hidiess in ) 2] - V008
alla fiommo Fib handesen 37 mm 69521 °C 960 Incondescante thead 37 mm IEC69521  °C 960
Ialtronic si riserva il diritto di modificore il materiole con cui realizza i propri prodotfi Italtionic con operate any change of the moterials without being obliged to forewar.

senza obbligo di preowiso.

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle, corrosive
or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan. It is
recommended to install the PLC, together with the matching switches and contactors, in a
dedicated electric cabinet and keep the cabinet ventilated. If the location has high ambient
temperature or heat generating equipment nearby, install forced convection devices on top or
sides of the cabinet to avoid over-temperature. During drilling or wiring, prevent the metal
particles or wire segments from falling into the PLC casing, which may cause fire, fault or
misact. After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very important
to ensure the power connectors for proper operation.

Separate the Spartan 21 1/0Os from heat, high voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
Spartan 21 1/0s. When configuring the layout of the Spartan 21 I/Os inside your panel, consider
the heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the operating
life of any electronic device. Consider also the routing of the wiring for the devices in the
electric cabinet. Avoid placing low-voltage signal wires and communications cables in the same
tray with AC power wiring and highenergy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring Spartan 21 1/Os. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm above
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and below the devices. Also, allow at least 25 cm of depth between the front of the modules
and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an accident or
material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or malfunctions and
could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
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and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment remains in a
safe state after repair.
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17.Revision Table

Rev. 2: 01-10-2024

Revision Number Date Changes
0 03/12/2020 First implementation
1 09/04/2021 Minor changes
2 01/10/2024 Added section 3.4 (“Isolation Precautions”)
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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